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You must install the software bundled on the Canon
Digital Camera Solution Disk before connecting the
camera to the computer.

@ Install the software.

Connect the camera
to the computer.
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Windows
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¢ This guide explains how to install the software programs and
briefly introduces their functions and operating procedures.

¢ Please read the software license agreement in this guide before ™
using the software. By using the software, you agree to be

bound by the terms of the agreement. DPOF



SAFETY PRECAUTIONS

The precautions noted within this guide are intended to instruct you in the safe and correct use of
the products and to prevent injuries or damage to yourself, other persons and property. Please
read and ensure that you understand them before proceeding to other sections of the guide.

AWarnings This symbol indicates topics that could lead to death or serious injury if
ignored or handled incorrectly.

AWarnings

¢ Do not play the supplied CD-ROM(s) in any CD player that does not support data CD-
ROMs. Playing the CD-ROM(s) in an audio CD player (music player) could damage the
speakers. It is also possible to suffer from hearing loss from listening with headphones to
the loud sounds of a CD-ROM played on a music CD player.

Disclaimer

e While every effort has been made to ensure that the information contained in this guide is
accurate and complete, no liability can be accepted for any errors or omissions. Canon
reserves the right to change the specifications of the hardware and software described
herein at any time without prior notice.

¢ No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language in any form, by any means, without the prior
written permission of Canon.

e Canon makes no warranties for damages resulting from corrupted or lost data due to a
mistaken operation or malfunction of the camera, the software, the CompactFlash™ cards
(CF cards), personal computers, peripheral devices, or use of non-Canon CF cards.

Trademark Acknowledgments

* ArcSoft, the ArcSoft logo and ArcSoft PhotoStudio are trademarks or registered trademarks of
ArcSoft, Inc.

¢ Adobe is a trademark of Adobe Systems Incorporated.

e CompactFlash is a trademark of SanDisk Corporation.

¢ Macintosh, Mac OS and QuickTime are trademarks of Apple Computer Inc., registered in the
United States and other countries.

o Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

¢ Other names and products not mentioned above may be registered trademarks or trademarks of
their respective companies.

Copyright © 2006 Canon Inc. All rights reserved.

Canon Customer Support

For Canon Customer Support contacts, please see the Canon Customer Support leaflet
supplied with your camera.

ArcSoft Customer Support
North America

46601 Fremont Blvd., Fremont, CA 94538
Tel: (510) 440-9901 (Mon. - Fri., 8:30 AM - 5:30 PM PST)
E-mail: support@arcsoft.com

Other Regions
Please see the ArcSoft web site: http://www.arcsoft.com/maininternational.html.



READ CAREFULLY BEFORE USING

Canon Software License Agreement

IMPORTANT - READ CAREFULLY BEFORE INSTALLING THE SOFTWARE! This document is a legal
agreement ("Agreement") between you and Canon Inc. (*Canon") and governing your use of this
software, and online manual or other electronic documentation, and sound data and image data,
if any (the "Software"). BY INSTALLING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE
TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT,
PROMPTLY STOP THE INSTALLATION PROCESS.

1. GRANT OF LICENSE

(1) Canon grants you a non-exclusive license to use ("use" shall mean storing, loading, installing,
executing, or displaying) the Software on your computers solely for use with Canon product. You may
allow other users of Canon's product to use the Software, provided that you shall impose on them on
the assurance that such users shall abide by the terms of this Agreement and shall be subject to
restrictions and obligations hereunder.

(2) With respect to the sound data and image data of the Software which is instructed to be used as
installed in a Canon's digital still camera or digital video camcorder product ("Product") under the
documentation for such Product, Canon grants you a non-exclusive license to install to and use them as
installed in such Product.

(3) You may make one copy of the Software solely for back-up purpose, provided that you shall reproduce
the copyright notice in the Software, on a medium of such back-up copy; provided, however, that you
may not make any back-up copy when the Software is provided to you as stored in a medium and you
use the Software as installed in permanent storage unit (e.g., hard disk drive) of a computer. Any other
copying of the Software is a violation of this Agreement.

2. RESTRICTIONS
You shall not use or copy the Software except as expressly granted or permitted herein, and shall not assign,
sublicense, sell, rent, lease, loan, convey or transfer to any third party the Software, and you also shall not
have any third party to do so. In addition, you shall not alter, translate, modify, convert to any other
programming languages, disassemble, decompile or otherwise reverse engineer the Software and you also
shall not have any third party to do so. You shall not modify, remove or delete any copyright notices
appearing on the Software or on a medium, if any, on which the Software is delivered.

3. OWNERSHIP
Canon and its licensor retain in all respects the title, ownership and intellectual property rights in and to
the Software. Except as expressly provided herein, no license or right, express or implied, is hereby
conveyed or granted by Canon to you for any intellectual property of Canon.

4. EXPORT RESTRICTIONS
You agree to comply with all export laws and regulations of the country involved, and not to export or
re-export, directly or indirectly, the Software in violation of any such laws and regulations, or without all
necessary approvals.

5. SUPPORT AND UPDATE
Canon, Canon's subsidiaries and affiliates, their distributors and dealers are not responsible for
maintaining the Software and helping you to use the Software, or providing you with any updates, bug-
fixes or support for the Software hereunder.

6. LIMITED WARRANTY AND DISCLAIMER
LIMITED WARRANTY. THE SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OR
CONDITION OF ANY KIND, EITHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING, BUT NOT
LIMITED TO THE IMPLIED WARRANTIES OR CONDITIONS OF DESIGN, QUALITY,
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. ALSO, THERE IS NO
WARRANTY OR CONDITION OF TITLE, QUIET ENJOYMENT, QUIET POSSESSION,
CORRESPONDENCE TO DESCRIPTION OR OF NONINFRINGEMENT WITH RESPECT TO THE
SOFTWARE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE IS
WITH YOU. SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU (AND NOT CANON, CANON'S
SUBSIDIARIES AND AFFILIATES, THEIR DISTRIBUTORS AND DEALERS) ASSUME THE ENTIRE COST
OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. SOME STATES OR LEGAL
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE
EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS
AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE OR
JURISDICTION TO JURISDICTION.
Canon, Canon's subsidiaries and affiliates, their distributors and dealers do not warrant that the
functions contained in the Software will meet your requirements or that the operation of the Software
will be uninterrupted or error free.




However, if you are provided with the Software as stored in @ medium, Canon warrants the medium to
be free from defects in materials and workmanship under normal use for a period of ninety (90) days
from the date of you obtained the same as evidenced by a receipt or otherwise.

CUSTOMER REMEDIES. Canon, Canon's subsidiaries and affiliates, their distributors and dealers' entire
liability and your exclusive remedy shall be the replacement of the medium not meeting the LIMITED
WARRANTY. The LIMITED WARRANTY does not apply if failure of the medium has resulted from
accident, abuse or misapplication of the Software and shall not extend to anyone other than you.

NO LIABILITY FOR DAMAGES. IN NO EVENT SHALL CANON, CANON'S SUBSIDIARIES AND
AFFILIATES, THEIR DISTRIBUTORS AND DEALERS BE LIABLE FOR ANY LOSS OR DAMAGES
WHATSOEVER (WHETHER KNOWN, FORESEEABLE OR OTHERWISE), INCLUDING WITHOUT
LIMITATION, ANY CONSEQUENTIAL, INCIDENTAL, DIRECT, INDIRECT, SPECIAL, PUNITIVE, OR
OTHER DAMAGES WHATSOEVER (INCLUDING DAMAGES FOR LOSS OF PROFITS, BUSINESS
INTERRUPTION, LOSS OF DATA, LOSS OF CONFIDENTIAL OR OTHER BUSINESS INFORMATION, OR
OTHER COMPENSATORY, INCIDENTAL OR CONSEQUENTIAL DAMAGES) ARISING OUT OF OR IN
ANY WAY RELATED TO THE SOFTWARE, USE THEREOF OR INABILITY TO USE THE SOFTWARE
EVEN IF CANON, CANON'S SUBSIDIARIES OR AFFILIATES, THEIR DISTRIBUTORS OR DEALERS HAVE
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME STATES OR LEGAL JURISDICTIONS
DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES, OR PERSONAL INJURY OR DEATH RESULTING FROM NEGLIGENCE
ON THE PART OF SELLER, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.
DISCLAIMER OF INDEMNITY. CANON, ITS LICENSOR, CANON'S SUBSIDIARIES AND AFFILIATES, THEIR
DISTRIBUTORS AND DEALERS SHALL ASSUME NO OBLIGATION TO INDEMNIFY YOU AGAINST ANY
CLAIM OR SUIT BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

7. TERM
This Agreement is effective upon your acceptance hereof by installing the Software and remains in
effect until terminated. You may terminate this Agreement by destroying the Software including any
and all copies thereof. This Agreement shall also terminate if you fail to comply with any terms of this
Agreement. In the event that this Agreement terminates for your failure to comply with this
Agreement, in addition to Canon enforcing its respective legal rights, you must promptly destroy the
Software including any and all copies thereof. Notwithstanding the foregoing, Sections 3, 5 through 7
and 9 through 11 shall survive any termination hereof.

8. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE
The Software is a "commercial item," as that term is defined at 48 C.F.R. 2.101 (Oct 1995), consisting
of "commercial computer software" and "commercial computer software documentation,” as such
terms are used in 48 C.F.R. 12.212 (Sept 1995). Consistent with 48 C.F.R. 12.212 and 48 C.F.R.
227.7202-1 through 227.7202-4 (June 1995), all U.S. Government End Users shall acquire the Software
with only those rights set forth herein. Manufacturer is Canon Inc./30-2, Shimomaruko 3-chome, Ohta-
ku, Tokyo 146-8501, Japan.

9. SEVERABILITY
In the event that any provision of this Agreement is declared or found to be illegal by any court or tribunal
of competent jurisdiction, such provision shall be null and void with respect to the jurisdiction of that
court or tribunal and all the remaining provisions of this Agreement shall remain in full force and effect.

10.GOVERNING LAW

The terms and conditions of this Agreement, the performance hereunder and the interpretation hereof
shall in all respects be governed and construed in accordance with the laws of Japan.
ACKNOWLEDGMENT

BY INSTALLING THE SOFTWARE, YOU AGREE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTOOD
IT, AND AGREED THAT THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF
AGREEMENT BETWEEN YOU AND CANON CONCERNING THE SUBJECT MATTER HEREOF AND
SUPERSEDES ALL PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER
COMMUNICATIONS BETWEEN YOU AND CANON RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY AUTHORIZED
REPRESENTATIVE OF CANON.
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Using the PDF Manuals

The following PDF-format manuals (hereafter PDF manuals) are provided to
explain the features and procedures for using ZoomBrowser EX and
ImageBrowser.

e ZoomBrowser EX Software User Guide (Windows)

¢ ImageBrowser Software User Guide (Macintosh)

installed to read
ese applications is
ownload it from the

crobat/readstep2.html

Viewing PDF Manuals

Viewing Manuals Downloaded from a Website

These PDF-format manuals are available on the Canon website. Use your
browser program to download these manuals from the following URL:
http://web.canon.jp/Imaging/information-e.html




This chapter explains what you can accomplish using the camera with the software contained
on the Canon Digital Camera Solution Disk.
It also lists the computer system configurations required to use the software.

About this Guide
* The explanations in this guide are based on Windows XP and Mac OS X v10.3. If you are
using another version of these operating systems, the actual screen contents and
procedures may vary slightly from those shown.
e The following terms are used in this guide.
Mac OS X is used for Mac OS X (v10.2-v10.4)
Memory card is used for CF cards, SD cards, MultiMediaCards and PC cards.

Method for Downloading to a Computer without Additional Software

Your camera uses a standard image transfer protocol called Picture Transfer Protocol (PTP).
With PTP and Windows XP or MaC OS X, you can download images without having to install
additional software. However, there are some inconveniences and limitations to this
downloading method. See the For Windows® XP and Mac OS X Users leaflet for details.
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It's so Simple! Make Prints Right at Home
Like a Pro

Shoot the images

See your Camera User Guide for shooting instructions.

Install the software on the

computer _\
.;.@_.
<

Windows (p. 11)
Macintosh (p. 44)

I
|
oo ] —

Just install the software once at the beginning.



( Connect the camera to the computer —\

Precautions for
Connecting the
Camera to the
Computer (p. 10)

See your Camera User Guide for connecting instructions.

(_ Download images to the computer -\

Windows (p. 16)
Macintosh (p. 46)

Windows (p. 21)
Macintosh (p. 50)

° o = =
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Unbounded Possibilities with Entertaining
Software

Print a Variety of Layouts

Print with the diverse layouts available in ZoomBrowser EX (Windows) and ImageBrowser
(Macintosh). The examples shown are from ZoomBrowser EX (Windows).

With One Photo per Page Print, Confirm all your images in one glance
printing images is also easy. with index (contact sheet) printing.

Stitch a Panorama Together
Create a panoramic image from a series of images with PhotoStitch.




Send an Image as an E-mail Attachment

Attach an image to an e-mail message by starting your mail software from within
ZoomBrowser EX (Windows) or ImageBrowser (Macintosh).

'

Operate the Camera Shutter from the Computer

You can use ZoomBrowser EX (Windows) or ImageBrowser (Macintosh) to operate the camera
shutter from the computer to shoot images (Remote Shooting). The recorded images are
downloaded directly to the computer.

The shutter is operated from the computer.

Edit a Movie

You can edit movies, linking movies and stills that have been downloaded to the computer,
adding text, such as titles, adding background music or applying various special effects.

Extract Stills from Movies

You can extract a still from the displayed movie and save it as a new image file. You can also
specify a range of frames and extract multiple stills.
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System Requirements

Please install the software on a computer meeting the following minimum requirements.

(0

Windows 98 Second Edition (SE)
Windows Me
Windows 2000 Service Pack 4

Windows XP (including Service Pack 1 and Service Pack 2)

Computer Model

The above OS should be pre-installed on computers with built-in USB

ports.
CPU Pentium 500 MHz or higher processor
RAM Windows 98 SE/Windows Me: 128 MB or more
Windows 2000/Windows XP: 256 MB or more
Interface UsB

Free Hard Disk

e Canon Utilities

Space - ZoomBrowser EX: 200 MB or more
- PhotoStitch: 40 MB or more
e Canon Camera TWAIN Driver: 25 MB or more
e Canon Camera WIA Driver: 25 MB or more
¢ ArcSoft PhotoStudio: 50 MB or more
Display A 1,024 x 768 pixels/High Color (16 bit) or better

Mac OS X (v10.2-v10.4)

The above OS should be pre-installed on computers with built-in USB

ports.

PowerPC G3/G4/G5

RAM

256 MB or more

Interface UsB
Free Hard Disk e Canon Utilities
Space - ImageBrowser: 200 MB or more
- PhotoStitch: 40 MB or more
¢ ArcSoft PhotoStudio: 50 MB or more
Display 1,024 x 768 pixels/32,000 Colors or better




0 ¢ A CD-ROM drive is required to install the software.
¢ Even when system requirements are met, not all computer functions can be
guaranteed.

¢ A sound card is required to play movie file audio tracks under Windows.

e With Windows, QuickTime 6.5 is required to save images merged with
PhotoStitch as the QuickTime VR type. It is also required to play and edit
movies on the Windows 98 SE, Windows Me and Windows 2000 platforms.
QuickTime is included on the Canon Digital Camera Solution Disk.

® Macintosh software cannot be used on disks formatted in the UFS (Unix File
System) format.

Programs and Compatible Operating Systems

The CD-ROM labeled “Canon Digital Camera Solution Disk” is provided with all models. It
contains the following programs.

Windows Programs

Compatible 05 | Windows | Windows | Windows | Windows Maior Functions

Program 98 Me | 2000 | XP )
*3 Downloading, displaying,

ZoomBrowser EX ® ® ® ® organizing and editing images

. *3 x4 | Driver for Canon brand cameras (for
TWAIN Driver o - ® | =" |Windows 98, Windows 2000)
WIA Driver — o — —*4 | Driver (Windows Me)
PhotoStitch*1 o3 o o ® Merging images to make panoramas
ArcSoft PhotoStudio®1 *2 o o Y @® |Advanced image editing

*1 Can be started from within ZoomBrowser EX.

*2 Image editing program manufactured by ArcSoft, Inc.
*3 Compatible with Windows 98 SE only.

*4 Driver not required because Windows XP supports PTP.

Macintosh Programs

Program e Mac OS X Major Functions
ImageBrowser ® Downloading, displaying, organizing and editing images
PhotoStitch*1 o Merging images to make panoramas

ArcSoft PhotoStudio™1 *2 o Advanced image editing

*1 Can be started from within ImageBrowser.
*2 Image editing program manufactured by ArcSoft, Inc.

0 See ArcSoft PhotoStudio (p. 72) for information about this program.
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Before You Connect the Camera to the Computer

Ensure that you have installed the software from the supplied Canon Digital
Camera Solution Disk before you connect the camera to the computer.

Precautions for Connecting the Camera to the Computer

e The connection may not operate correctly if you attach the camera to the computer with an
interface cable via a USB hub.

¢ The connection may not operate correctly if you are using other USB devices, excluding USB
mice or keyboards, at the same time as the camera. If this occurs, disconnect the other
devices from the computer and try reconnecting the camera.

¢ Do not connect two or more cameras at the same time to the same computer. The
connections may not operate correctly.

e Never allow the computer to go into standby (sleep) mode while a camera is connected via
the USB interface cable. If it does happen, never disconnect the interface cable. Try to awaken
the computer with the camera in the connected state. Some computers will not awaken
properly if you disconnect the camera while they are in standby (sleep) mode. Please refer to
your computer manual for instructions regarding the standby (sleep) mode.

*You are recommended to power the camera from a household power source
(AC adapter) when connecting to a computer (if available for your camera
model). Ensure that you use fully charged batteries if you will not be using a
household power source.

¢ See the Camera User Guide for procedures connecting the camera to the
computer.




This chapter explains the basic procedures for installing the software and connecting the
camera to a computer. Read this material before you connect the camera to the computer.

Installing the Software and USB Driver

Start by installing the software from the Canon Digital Camera Solution Disk.

PhotoStudio.

Iﬁl See ArcSoft PhotoStudio (p. 72) for details on how to install ArcSoft

ltems to Prepare
e Your camera and computer

e Canon Digital Camera Solution Disk
e Interface cable supplied with the camera

Installation Procedures

1 Confirm that the camera is NOT connected to
the computer.
If it is, disconnect the cable. The software cannot
be properly installed if the camera is connected to
the computer at the start.

2 Close any programs that are running.



]2 Using the Software on the Windows Platform - Preparations

3  Place the Canon Digital Camera Solution Disk in the
computer’s CD-ROM drive.
If the installer panel does not appear automatically, use the
following procedures.

How to Display the Installer Panel
Use the following procedures to display the installer panel if it does not appear
automatically.

Windows XP
1. Select [My Computer] from the [Start] menu.
2. Right-click the CD-ROM icon and select [Open].

iy
3. Double-click the [SETUP.EXE] %) icon.

Windows 2000, Windows Me, Windows 98 SE
1. Double-click the [My Computer] icon on the desktop.
2. Right-click the CD-ROM icon and select [Open].

(i
3. Double-click the [SETUP.EXE] ‘% icon.
Some computers may not display the [.EXE] file name extension as shown above.

4 Click the Digital Camera Software [Easy
Installation] button. Canon DIGITAL CAMERA

To individually select the software to install, Solution Disk
click [Custom Installation].

Dirag

Easy Installation
e/,

|
Installer Panel

Follow any instructions to restart your computer, if they appear. If the
following window appears, continue with the installation.
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5 If other software is running, close each
program before clicking [OK].

Start instaling Digital Camera Solution Disk,
Close any other open applica click [OK].

6 Review the installation settings and
click [Install]. oyl Conrmanion

[ T

tee 3 Inetalason

i i

The items displayed here differ according to
the software installed. ‘

7 Click [Yes] if you agree to all of the —_—
terms of the software license r Lo A
agreement. l—— - :
The installation will start. P e e
50 o A U S
RN ¥ FIOF S BOTALLATEN OO
Follow the onscreen instructions to e

proceed. e e L e

ick [ Yo 00 acompt e Liers greemanst. If you cck (o], the nstaaton.
BN it ey L

=




]4 Using the Software on the Windows Platform - Preparations

8 When the installation is over, select
[Restart computer immediately
(Recommended)] and click [Restart]. ” —

At this stage, do NOT remove the Solution st s oy Gocommnc

Disk from the CD-ROM drive yet.

If there is no need to restart the computer, the [Finish] screen will display. Click [Finish],
remove the Solution Disk from the CD-ROM drive and proceed to Step 10.

Users of Windows XP and Windows 2000 must log in as an Administrator

(computer system administrator) after restarting to carry out the
subsequent procedures.

9 Remove the disk from the CD-ROM drive when your
normal desktop screen appears after restarting.

This concludes the software installation.

Continue by connecting the camera to the computer so
that the USB driver can be utilized.

Iil See Uninstalling the Software (p. 74) to delete the installed programs.

10 Attach the camera to the computer with the
interface cable and set the camera to the
correct mode for connecting.
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Procedures for attaching the camera to the computer and placing the
camera in the correct mode for connecting vary between camera models.
See the Camera User Guide.

If the Digital Signature Not Found window  rrrErrmreT x
appears, click [Yes].

The Miciosoft digital signature affims that software has
been tested with Windows and that the software has not
been ahered since it was tested.

The soitware you 2re about 10 install does nat contain 2
Miciosoft digital sianature. Therefore, there s o
quarantee that this saftware works cormectly with
Windaws.

HRRHHHH RN

1F pou want 1o s=arch for Micrasoit digitally signed
soltware. visit the Windows Update Web site ol
hitp:/windowsupdate. microsolt.com to see if one is
avaiable

Do you want ta continue the installation?

‘ ! No Mors Info

The USB driver will automatically finish installing onto the computer when you attach the
camera and open a connection.

Dialogs similar to the following will appear during this process (first time the camera is
connected to a computer only).

Windows XP
The dialog on the right will appear after a
few moments. _ g

i) Found New Hardware |*| [recycls Bin

Canon Digikal Camera

Windows 2000/Windows Me/Windows 98 SE
Restart the computer according to the instructions if you are prompted to do so by a
message.

A dialog allowing you to set the default settings will display after installation. See Using
the Software on the Windows Platform — The Basics (p. 16) for the subsequent
procedures.

e See USB driver installation not proceeding well in the Troubleshooting
section (p. 78) if you are having problems installing the USB driver.

e See Uninstalling the USB Driver (p. 75) to delete the USB driver installed
with these procedures.

e See If You Were Using ZoomBrowser EX Version 2 or 3 (p. 85) if you
were previously using either version.

This concludes the software and USB driver installation and the procedures for connecting the
camera to the computer.
You may now download camera images to the computer (p. 16).



This chapter explains the procedures for using ZoomBrowser EX to download the camera's
images to the computer and print them.

Read this chapter after completing the preparations in the Using the Software on the Windows
Platform — Preparations section.

Downloading Images to the Computer

Begin by downloading the images to your computer. The downloading procedure is slightly
different according to whether you are using a camera to computer connection (see below) or
a memory card reader (p. 19).

era is connected to a
imately 1000) on the
that

You may not be able to download ima
computer if there are a large num
memory card. Use a memory ¢

Camera to Computer Connection

1 Attachthe supplied interface cable to the computer’s USB port and the camera’s
DIGITAL Terminal. Prepare the camera for communication with the computer.

the correct mode for connecting vary between camera models. See the

Iﬁl Procedures for attaching the camera to the computer and placing it in
Camera User Guide.

The Camera Contr0| WindOW WI” appear' & CameraWindow - Canon JX0000XX%KY

Acquire Images [ Print || Set to Camera | Remate shoating |

Dowrloads using camera

Press the camera's button

Camera Control Window

Downloads using computer
Starts to download images
=

Lets you select and download images




First Time Camera is Connected to a Computer
Set the following settings the first time you connect the camera to the computer. These
procedures are not required from the second connection onward.

Select [Canon CameraWindow] when a
dialog (Events dialog) similar to that on
the right displays and click [OK].

Camera connected

Your camera model name or [Canon

Camera] will appear here. Select the program to launch for this action:
e e : A~
Different programs may display ) owinloads |m: i e Eeme 1
according to your computer setup. 72 Microzoft Scanner and Camera ‘wizard
Download pictures from a camera or scanner
A

[ tshways uze this pragram for this action

@ —

If this Events dialog does u and select
0 [All Programs] or [Pro Utiliti
[CameraWindow]

[CameraWind

Download the images.

Download the images using the camera or
the computer. By default, the downloaded
images are saved into the [My Pictures] EonnicgllliT camera

f0|der- ‘ Press the camera’s button
T

Downloads using computer
Starts to download images

Lets you select and download images

ameraWindow - Canon XCOCODO0OKK

Acquire Images | Print | Set to Camera | Remote shooting|

Placing a check mark here causes this
window to automatically open when the
camera and computer are connected.

[¥] Displays this screen when the camera i connected

You can adjust the settings, such as the type —f pefeerces.. |

of image downloaded and the destination
folder, by clicking [Preferences].

17
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Using the Camera to Download Images (Direct Transfer Function)

e If the conditions are right for the Direct Transfer function, the Direct
Transfer settings menu will appear in the LCD monitor. In addition, the
Dyas (Print/Share) button will light if your camera is equipped with one.

¢ See the Camera User Guide for instructions regarding Direct Transfer
settings and procedures.

Set the Direct Transfer settings on the
camera and press the Dhas (Print/Share)
button or the SET button.

Direct Transfer

All Images...
New Images...

DPOF Trans. Images...
[ Select & Transfer...
& Wallpaper...

Using the Computer to Download Images
Click [Starts to download images].

&% CameraWindow - Canon XXXXXRM000L

Acquire Images | Print || Set to Camera | Remate shoating|

Downloads using camera

= |
@QNl Fress the camera's button
bl

Downloads using computer

Starts to download images

ﬁE. Lets you select and download images
Displays this screen when the camera is connected

¢ By default, all the images that have yet to be downloaded will download.

*To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the image type to be downloaded.

e Click [Lets you select and download images] to show the camera images
in a list, check the images before downloading and download only
selected images.

The downloaded images will be saved into folders according to their shooting date.



By default, when downloading is complete,
the thumbnails (tiny versions) of the
downloaded images display in
ZoomBrowser EX's Main Window.

= £ G e e [
‘Zoom Mok | ool Moete | Pariems bocke|
memmE > 2 |FH-0- [ k[8 S = =

Thumbnail

The downloaded symbol displays on
downloaded folders (the symbol will ]
disappear when you exit ZoomBrowser EX).

Next, print out the images (p. 21).

Memory Card Reader Connection

T insert the memory card into the reader.

Use a separately sold card adapter if required.
See the manual for the memory card reader for its connection and handling instructions.

2 sclect [View/Download Images using .
. CANDN, DC {H:) X
Canon CameraWindow] when the fad
dialog to the nght appears and click ‘windows can perform the same action each time vou insert
adizk or connect a device with this kind of file:
[OK]. .
X . . m Fictures
The Camera Control Window will display. What do you want Windaws to do?
t:ﬂ uzing Photo Printing ‘wizard ~

= WView a shideshow of the images
uzing *Windows Fieture and Fax Yiewer

_%2 Copy pictures to a folder on my computer
uzsing Migrozaft Scanner and Camera wizard

== Wiew Images =
Using ZoomBrowser B

-

[

Programs] or [Programs], followed by [Canon Utilities], [CameraWindow],
[PowerShot - IXY - IXUS - DV 6] and [CameraWindow], and proceed to

Step 3.

Iﬁl If the dialog above fails to appear, click the [Start] menu and select [All
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3 dlick [Starts to download images].

¢ CameraWindow - G:ADCIM

Acquire Images | Print | Set to Memory Card

e
gl Starts to download images

Lets you select and download images

You can adjust the settings, such as the type

of image downloaded and the destination _

folder, by clicking [Preferences].

download to the [My Pictures] folder.

¢ To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the image type to be downloaded.

e Click [Lets you select and download images] to show the memory card
images in a list, check the images before downloading and download
only selected images.

® See Memory Card Folder Structure (p. 77) for information about
memory card folder structures and file names.

Iﬁl By default, all the images that have yet to be downloaded will

The downloaded images are saved into folders according to the shooting date.

By default, when the download is complete, the thumbnails (tiny versions) of the
downloaded images display in ZoomBrowser EX‘s main window.

Next, print out the images (p. 21).
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Printing Images

There are two ways in which images may be printed: One Photo per Page Print and Index Print.
This section explains the One Photo per Page Print method.

e Movies cannot be printed, but you can print stills after they have been
extracted from movies and saved to files.
¢ To use the Index Print option, click [Print] in the Main Window, followed by
[Index Print].

One Photo per Page Print

This option prints one image per page in a standard "photo" format. If you select multiple
images, it will print them on the corresponding number of pages.

1 ik [Print] in ZoomBrowser EX's Main Window, followed by [One Photo Per Page
Print].

&7 Inomilrowsor £X - D:\Decements and Sattings ooty Documents\y Petares\ 2005 0

Tacks = = ::ymm 1
Zoom Modde | Seml Mode | Preview Mode “ X Carsais Surgr ZoamMode ool Mods | Previow Mode |
20050 8 & - Fr T 4 G0~ |®
. T v cuisty
@ Fa
Ewpont

Firt

Dres Phot pex Pages Pied

s Prei

Pk Lisg Dther Sohuasss

'ﬂl 3

e If you have installed the Easy-
PhotoPrint program that
accompanied a Canon-brand
printer, you will proceed to the
Easy-PhotoPrint printing window
shown at the right when you
select [One Photo per Page Print]
according to the default settings.
If a window similar to it opens,
read the Help menu for Easy-
PhotoPrint for instructions to proceed.

¢ To proceed to the ZoomBrowser EX printing window as shown in Step 2
when you select [One Photo per Page Print], click the [Tools] menu and
select [Preferences], followed by the [Printing] tab. Select [Use the Print
Function in ZoomBrowser EX].
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2 After confirming that [1. Select Images] is selected, select images.
You can select multiple images by holding the [Ctrl] down while clicking on successive

images.
Fie Edt Vew Took Inbeenet Help

Zexem Mexte | Seroll Moxde | Prervaees Mo
mE e € 4+ |B-0-|x |8 5 o | Show | simages -

1
g
H

selected images
changes to blue.

43 Mlstan bz s Mer

| Faverie Foidens| A1 Foiden |
et -

oo otumas
oy
CF: [N—
W 01

The background of
|
|
|
|

3 dlick [2. Printer and Layout Settings] and adjust the categories as you feel
necessary.

Selects the printer
and the paper size
etc.

Sets printing to
"borderless," etc.

Place a check mark
here to print
shooting date/time
information with
images.

Sets the number
of print copies

This button switches between images if
multiple images were selected.

4 Click [3. Print].
Printing will start.
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This chapter explained the ZoomBrowser EX basics. Once you have mastered them, try the
advanced techniques.
Using the Software on the Windows Platform — Advanced Techniques (p. 24).

¢ A PDF-format manual for ZoomBrowser EX is also available. It provides
further information about the program's features and procedures. See Using
the PDF Manuals (p. 2).




This chapter explains various ZoomBrowser EX features.
Proceed to this chapter once you have mastered the basic ZoomBrowser EX procedures in the
Using the Software on the Windows Platform — The Basics chapter.

Information about Your Camera (p. 87).

Iﬁl To confirm whether your camera supports these functions, please refer to

The ZoomBrowser EX Windows

This section describes the principal ZoomBrowser EX windows: the Main Window, Viewer
Window and Properties Window.

This window is for displaying and organizing images downloaded to the computer.

Task Area (p. 25) Function Buttons (p. 27)

Display Mode
1 (p- 26)
Display Control

Panel (p. 27)

1
Browser Area (p. 25)

Folders Area (p. 25) Switches between showing and hiding
the Task Area and Folders Area.



Task Area

e ZoomBrowser EX's tasks are arranged here like
an index.

e Click a Task button to carry out the desired
task.
These features are described in ZoomBrowser
EX Features (p. 30)

Zae ok | S0k M | Prvioe Mok
ammm€ > 4 -0k ]E S

Folders Area

e Use this area to select folders. The images in the selected folder display in the Browser Area.
If you select a network drive in advance with Windows Explorer, you can display network
folders, but you cannot add, change or delete those folders in the Browser Area.

e |f you selected Favorite Folders, only the folders registered in advance as Favorite Folders will
display. You are recommended to register a folder that you use frequently as one of the
Favorite Folders. If you selected All Folders, all the folders will display.

Methods for Registering a Favorite Folder

o If [Favorite Folders] is displayed: click [Add] and select a folder.

o If [All Folders] is displayed: select a folder and click [Add to Favorites].

¢ To delete a folder in the Favorite Folders area, select a folder and click the [Delete] button.

Browser Area

*The images in the folder selected in the Folders Area will display here.
The display style will vary according to your Display Mode selection.

Methods for Selecting Images in the Browser Area

e Selecting a single image: click on an image.

e Selecting multiple images: click on the first image and then hold the [Ctrl] key down
while clicking on additional images.

o Selecting consecutive images: click on the first image and then hold the [Shift] key down
while clicking on the last image.

e You can sort the image order in the Browser Area by file name, shooting date or other
characteristics by clicking the [Tools] menu and selecting [View] and [Sort by].
¢ The following icons will display around images according to their attributes.

E Images shot with the camera's Stitch Assist mode

m RAW images

b Movies

Images with sound memo attachments
Protected images

Images shot with the camera's AEB function

BOERESH

Images shot with the camera on end that are rotated in the display only
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Display Mode

o Selects the display style for the Browser Area.

Zoom Mode ;
Displays all the images in a folder as thumbnail = - =
. . n X 8 s |E = EoEa - £
images. This mode is convenient for searching T st v

for images since many can be displayed at sera b B
once.

If additional folders are nested within a
folder, their images are displayed as
thumbnails as well.

If you move the mouse cursor over a folder,
=} will display on the upper right. Clicking
here displays that folder zoomed in.

Scroll Mode

This mode is convenient for checking the
images in multiple folders at once. If the
displayed folder is at the highest level, then all
thumbnails in the lower-level folders also
display. You can change the folder level (folder
depth) by clicking the [Tools] menu and
selecting [Preferences].

The images within nested folders also
display.

Preview Mode
This mode displays the image at a larger size as
well as the image information.

Positioning the mouse pointer over a thumbnail causes the image to appear
at a higher magnification in a Mouse Over Window. You can turn off this
function by clicking the @ - [Show Information], and removing the check
mark from the [Show Mouse Over Windows] option.
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Display Control Panel

¢ This panel adjusts the display settings for the Browser Area.

Selection Menu Fit to Window Display Size
Use this to select or deselect all Changesthethumbnailsizeto Changes the size of the
the images in the Browser Area. fit them into the window. thumbnail in the Browser Area.
€ a éﬁvtlivk@l&ﬂ = ;IhF
Show/Hide Image Information Menu Filter Images
Use this to display or hide image This feature filters your images by
information beneath the thumbnails, their Star Ratings, displaying only
such as the file name, shooting date those images in the Browser Area.
or Star Rating. One of three Star Ratings can be
assigned to an image in the Viewer
Select Button Window, the Properties Window, or
Use this to select images in the information column in the
in Zoom mode. Preview Mode.

Function Buttons
e These buttons are available for executing various functions.

View Image Button Slide Show Button Rotate Button
Displays the selected image Starts a slide show of the Rotates the selected
or movie in the Viewer selected images. image.

Window.

'\.I'IEW Image Prnperhes Slide Show Search ﬁ Delete @ Rokate
Properties Button Search Button Delete Button
Displays information about Searches for images Deletes selected
the selected image in the using such criteria asthe images or folders.
Properties Window. Star Rating,

modification date,
shooting date,
comments or keywords.
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Double-click an image in the Browser Area to display it in the Viewer Window.

Edit Menu —Display AF Frame

You can edit, eliminating red eyes, Displaysthe AF Frame

adjusting colors, cropping and (area used to focus).

inputting titles. You can also use it to Shooti

tart th for editing. ooting :

start up other programs for editing ormation gymﬁron_‘ze Btr]tton
i i i Displays image o8

Prints the displayed image. sr:o%ti)r/wgl g gultllpledlmages are

information. Isplayed.

Image Selector Split Screen

Button Button
Switches between Displays
images. multiple
images at
Displays images in — once. This is
the Viewer handy f_or
Window at their comparing
actual size. images.

Sets the image  —
display size to the
size in the Viewer
Window.

Zoom Star Rating

Changes the image Sets the Star Rating for an image.

zoom setting.
Full Screen Button
Displays the image in the full screen mode. Click the
image or press any key on the keyboard to restore the
normal display mode.

¢ If a RAW image is displayed, the [Display Original Image] button displays
beneath it. Clicking this button displays the converted image in the Viewer
Window.

¢ If you are using Windows XP and display a movie file, the B (Capture Still
Frame) button will display beside the Star Ratings. Clicking this button
extracts still images from movies.
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Properties Window

The Properties Window displays when you select an image in the Browser Area and click the
Properties button. The Properties Window does not display in the Preview Mode.

Shows or hides

categories. [ET—
M odified; 77342005
Star Rating A File Size: 4706 KB
Sets the Star Rating : ‘Dm;l:ETS'Z:- TJ‘;UEHZUU
for an image. S
Py 5. —————4—Plays a sound memo attached
Beff D ) St B to an image.
File Mame:
[145:_o0o1 \
Protect
i Prevents an image from being
IHTHEY L Protec! overwritten or deleted.

Commem;—l
t

Comment
You can type a comment here.

Kepword

Keywords
Sets the keywords used in
Biighiness Histopam: ———— M.  scarches.

_I—Brightness Histogram
A graph of the highlights and
shadows distribution in an

image.

Shaoting Information:

Shooting Information Trem Name Tahie =
i i File Name IMG_0001.JPG =
PISpIayS (.jetaIIEd ) | Camera bodel Name  Canon x4 B
information about the Shooting Date/Time  3/3/2004 8:15:22 AM
H H Shooting Mod; Ak

§hoot|ng settings when the T Bt oI
image was captured, such fu [Apetture Valugl 7.1 5

Linht Matannn Centar Wainhtad duen =
as the shutter speed or
exposure setting. The ( < Frevious Hat > _)._ Image Selector Buttons
camera model will Switches between images.

determine what
information is displayed.
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ZoomBrowser EX Features

This section briefly introduces the Task Area functions.

To confirm whether your camera supports these functions, please refer to
Information about Your Camera (p. 87).

Acquire & Camera Settings

Connect to Camera ‘L@ Acauire & Camera Settings
Clicking this connects to your camera and
opens the Camera Control Window, which lets
you perform the following operations.

eAcquire Images
Downloads images from the camera/memory card (p. 16, 19).

Additionally, you can download sound files recorded with the Sound Recorder function on
the camera.

*Print Images
Selects and prints the images in a camera. You can print numerous ways, using DPOF
settings, the Index Print option, One Photo per Page Print option, or by selecting images
before printing.

eSet to Camera
Sets camera settings, such as the My Camera settings (p. 39). It also uploads images from
the computer to the camera.

*Remote Shooting
Allows you to operate the camera shutter from the computer (p. 35).

Connect to EOS Camera
This can only be used with EOS series cameras. For details on this function, see the user guide
for your camera.

Acquire Images from Memory Card

Download images from a memory card (p. 19).

You can also download sound files recorded with the Sound Recorder function, or select
images on the memory card and print them.

View & Classify —

View as a Slide Show § 0 View & Classify
Starts a slide show of the images selected in the
Browser Area.

Rename Multiple Files
Changes the file names of the selected images in a single pass.

Classify into Folder
Classifies images and saves them into a specified folder.

Search

Performs image searches using criteria such as the Star Rating, modification date, shooting
date, comments or keywords. Star Ratings, comments and keywords can be set in the image
information column in the Preview Mode or in the Properties Window.




Edit
Edit Image ‘ @ E dit ‘
Allows you to perform image editing, such as

cropping, image correction and red-eye
correction. You can also use it to start other image editing programs.

Stitch Photos
Merges multiple images and creates a single large panoramic image (p. 38).

Edit Movie
Edits movies or still images strung together. You can add text as titles, or background music,
and apply various effects (p. 34).

Process RAW Images
Converts RAW images into standard images. You can adjust the image brightness, contrast
and color balance among other attributes during conversion.

Export
Export Still Images ‘@ E wport

Allows you to change the image size or type,
and export it as a new image.

Export Movies
Allows you to change the movie size or type, and export it as a new movie.

Extract frames from a movie
Extracts still images from movies over a specified interval and saves them as image files
(Windows XP only).

Export Shooting Properties

Allows you to select the necessary data from the shooting information and export it as a text
file.

Export as a Screen Saver
Exports the image as a screen saver file.

Export as a Wallpaper
Exports the image as a wallpaper file.

Backup to CD
Copies images to a CD-R/RW disk for backup.

The Backup to CD function can only be used on computers satisfying the
following requirements.
e\Windows XP is preinstalled
e A CD-R/RW drive is included as standard equipment
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Print
One Photo per Page Print ‘% Prirt

Prints one image per page (p. 21).

You can print "photo" prints easily.

Index Print
Lines up small versions of the images in rows and prints.

Print Using Other Software
Select the software to use and then print.

Internet
Email Images

Converts the selected images to the

| Fkernet
appropriate size for transmission by e-mail. You

can also use it to automatically start an e-mail program after conversion.

¢ To return to the previous screen after selecting a task, click [Return to Main
Menu] at the bottom of the task screen.

*Various Help functions are available in ZoomBrowser EX. Click the [Help]
menu, [?] button or [Help] button to display topics about operational
procedures or the functions available.
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Replaying Movies

1 Doubleclick an image with a movie icon in ZoomBrowser EX's Browser Area.
The Viewer Window will open and play the movie.

You can save the displayed
scene as a still image by
clicking here.

You can control the
movie's playback and
sound volume.

Windows 2000, Windows Me and Windows 98 SE
QuickTime is required to play and edit movies. To install QuickTime, please follow these
procedures.

1. Place the Canon Digital Camera Solution Disk in the CD-ROM drive.
If the installer panel fails to appear automatically, display it using the procedures in the
How to Display the Installer Panel section (p. 12).

2 Click the QuickTime [Install] button.
Canon DIGITAL CAMERA

Solution Disk

Easy Installation |
—

Follow the onscreen instructions to proceed with the installation.
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Editing Movies

You can create and edit movies: link movies and stills that have been downloaded to your
computer, add background music, superimpose titles and other text, and apply various effects
to the movies.

e The QuickTime program is required to replay or edit movies on the Windows
2000, Windows Me or Windows 98 SE platform. Install it during procedures
in the "Replaying Movies" topic in the Windows 2000, Windows Me and
Windows 98 SE section (p. 33).

e Movies are saved as Motion JPEG AVI movies.

Click [Edit] in ZoomBrowser EX’'s Main Window, followed by [Edit Movie].

2 cClick [1. Add Images] and select the image (movie or still) you wish to edit.
You can select multiple movies or stills.
3 Follow the steps at the left of the window to edit the movie and save it.

Follow these steps Click this button for detailed
to proceed. operational instructions.

i g = e, vl o g a2 e o

{— | ——

Instructions

Click this button to

play the movie
----- being edited.
e 1
St.oryboard Area — — Transition Effects Box
Displays thumbnails of the selected Appears between adjacent images
images. and displays the symbols of the

Links images in order from left to right. transition effects linking images.
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Operating the Shutter Remotely

You can record still images by using a computer to control the shutter of a connected camera.
This is particularly useful for checking images on the larger display of the computer as you
record them and for high volume photography without worrying about filling the camera’s
memory card.

Preparing for Remote Shooting

1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

¢ Methods for connecting the camera to the computer and placing it in
the correct mode for connecting vary between camera models. Please
refer to the Camera User Guide.

e Perform the settings described in First Time Camera is Connected to a
Computer (p. 17) the first time you connect the camera to the
computer.

The Camera Control Window will display.

2 Open the lens cover or remove the lens cap on models equipped with them.
Proceed to the next step if your model does not have one.

3 CIICk the [RemOte ShOOting] tab &% CameraWindow - Canon Je000000XXE \Z| E|
4 cick [Starts Remote Shooting]. | Acauis Images | Pirt | Set o Caffers | Remote shosling

E tarts Remote Shooting

Displays this screen when the camera is connected

B select a destination for the captured images and click [OK].
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RemoteCapture Task Window

The RemoteCapture Task window has the following features.

Shows/Hides the Size and Resolution Selector
viewfinder or detailed

settings area.

RemoteCaptureTask - BT}
File(F) Camera(C) Shooting(S) Help(H)
@Hmawawﬁnuar @.. [0 H  Release

@Hideshommgde&aus = ,— -
You can add = Ao commenits shown below = j
comments to images |/l
by placing a check
mark here and
typing text in the
boxes below.

Viewfinder Display
Click the [Start/Stop
Viewfinder] button
while a connection to
the camera is open to

Selects the size and resolution at which images are captured.

Rotation Settings
Sets the rotation
parameters for
images after they are
captured.

Release Button
Releases the
shutter.

Slide this to zoom
the camera in or out.

Start/Stop Viewfinder
Button

Starts or stops the
viewfinder display.

Refresh Button
Resets the exposure,
focus and white
balance.

display the image
appearing in the
camera'’s viewfinder.

Set the basic camera settings here.

¢ The settings available in the RemoteCapture Task window vary between
camera models.

e RemoteCapture Task locks the exposure and focus settings for the subject
matter in the Viewfinder section. If the lighting or distance to the subject
changes, click "8&7 to reset these settings.
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Remote Shooting

Ensure that you turn off your computer’s standby mode before you begin
remote shooting. The device performance cannot be guaranteed if the
computer enters the standby mode.

Click and check the subject in the viewfinder.

Change the image size or resolution, the rotation settings and the settings at the
bottom of the window as required.

If you intend to hold the camera vertically to photograph a subject, you can save the
image to the computer with the correct orientation if you set the rotation settings in
advance.

N =t

If your camera’s shooting mode is equipped with the Auto Rotate
function and you set it to On, the image will automatically be rotated
and appear in the correct viewing orientation in the RemoteCapture Task
window.

3 Click the [Release] button.

*You can release the shutter by pressing the camera’s shutter button or
the keyboard’s space key.

e Other than the shutter button, the camera's buttons and switches,
including the zoom, cannot be operated while the camera is being
controlled with the Remote Shooting function.

* You may notice that the interval between the shutter release and
activation is slightly longer for remote shooting than when the camera
is used independently.
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Merging Panoramic Images - PhotoStitch

You can create a wide panoramic image by merging several images. It is easier to merge
images if they are shot with the camera's Stitch Assist mode because PhotoStitch can
automatically detect the image order and orientation.

Images Shot in Stitch Assist Mode

A sequence of images shot in Stitch Assist mode is saved into a single folder when it is
downloaded from the camera. In addition, the symbol below displays by the image in the
Browser Area.

Symbol displayed by images shot in Stitch
Assist mode. P

Assist mode.
eImages shot in Stitch Assist mode with a wide converter, teleconverter
or close-up lens cannot be merged accurately.

Starting PhotoStitch

1 cik [Edit] in the ZoomBrowser EX’s Main Window and click [Stitch Photos].
2 ik [1. Select Images] and select several images in the Browser Area.
3 Click [2. Open PhotoStitch].

Iﬁl ¢ See the Camera User Guide for information about shooting in Stitch

L

. | j Marge Images Shot in Stitch Assist Mode

Instructions

e

-

STA_DSTE PG

STB_OSTH PG

‘1

STC0580.9G | STD_OSE1.PG

i of s

4 Merge the images following the instructions in the guidance panel at the top of
the PhotoStitch window.
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Enjoy Customizing Your Camera with the My
Camera Settings

The start-up image, start-up sound, shutter sound, operation sound, and self-timer sound are
called the My Camera settings. You can add your favorite images and sounds from your
computer to the My Camera settings. This topic explains how to upload the My Camera
settings saved onto your computer to the camera and vice versa.

Displaying the My Camera Window

1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

* Methods for connecting the camera to the computer and placing it in
the correct mode for connecting vary between camera models. Please
refer to the Camera User Guide.

e Perform the settings described in First Time Camera is Connected to a
Computer (p. 17) the first time you connect the camera to the
computer.

The Camera Control Window will display.

2 Click the [Set to Camera] tab.

3 Click [Set My Cameral.
The My Camera window will display.

Confirmsf/changes camera settings

=l
;!ﬁl Uploads images to the camera

Displays this screen when the camera is connected

Fieferences




40 | Using the Software on the Windows Platform — Advanced Techniques

The My Camera Window Features

ZoomBrowser EX already contains several pre-recorded My Camera settings. You can check
these items with the My Camera window.

Tabs
Click here to switch between adjusting the settings individually or in themed sets.

. . Play Button
MRS Plays the audio from the
b= S0 a6 a theme o€ kel . . .
settings file in the
camera.

Displays the settings in
the camera.

St iy Camarn D 1y 3 ot by

Displays the list of e
settings files saved | ErT -

My Computer

onto the computer.

Delete Button

”_’@h' Deletes a settings file
SRS from the camera.
W
Play Button _ gave to Camer: Button
Plays the audio from aves a computer
the selected settings — . settings file onto the
i — camera.
file. —
Delete Button ——————— - Save to PC Button
Deletes a settings file from Saves a camera settings
the computer. file onto the computer.

For cameras that can only register one My pueisae

Iﬁl Camera setting, the [Return to factory default
settings] button will display. Clicking this
button will return the My Camera setting to
the factory default setting. -
&y |

Fieturmn to factory default settingsl

N
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Saving the My Camera Settings to the Camera

e My Camera settings can be selected and saved in either of two ways to the
camera: individually or in theme sets.

*The “Animal” theme, for example, features an animal in the start-up image
and animal calls in each of the sound files. The names of the prepared files
for the various My Camera settings themes all begin with the same root
name. The start-up image and sound files in the "Animal" theme, for
example, all begin with "Animal~".

Do not detach the interface cable, turn the camera power off or disconnect

0 the camera from the computer while the My Camera settings are being saved
to the camera or the settings from the camera are being saved to the
computer.

1 select the [Setup as a theme] tab in the My Camera window.
To set the start-up image or sound individually, click the [Set individually] tab and select it.

Select the settings file you wish to save to the camera from the My Computer list.
Select the setting from the Camera list that you would like to change and click
[Save to Cameral.

This concludes the process of saving the My Camera settings to the camera.

The Camera list setting will change to the selected file. If a setting for this category has
previously been saved to the camera, it will be overwritten.

(2] L

Repeat steps 1-3 as required.
To use this data on the camera, change the start-up image and sound settings on the
camera itself. Please see the Camera User Guide for these instructions.

Saving the Camera’s My Camera Settings to the Computer

1 Sselectthe [Setup as a theme] tab in the My Camera window.
To set the start-up image or sound individually, click the [Set individually] tab and select it.

Select the settings files from the Camera list that you wish to save to the
computer.

Click [Save to PC].
Add a name to the settings file you are saving and click [OK].

This concludes the process of saving the My Camera settings to the computer.
Repeat steps 1-4 as required.

Rk N
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3 Follow the instructions at the top part

Using the Software on the Windows Platform — Advanced Techniques

Adding New Data to the My Camera Window

Create a new image or sound file and add it to the My Camera window.
¢ Adding Image and Sound Files After Creating Them

Adding Original Start-up Images and Sounds After Creating Them

You can effortlessly create start-up image and sound files using the My Camera Maker
program (Windows XP or Windows 2000 only).

T Click the [Edit] menu in the ZoomBrowser EX Main Window and select [Manage
My Cameral.

The My Camera window will display.

2 Click the [Set individually] tab in the My Camera window, followed by the [Create
My Camera Data] button.

My Camera gl

Setup 3z atheml Set individually |

Select by Camera Data type and set individually.

Diata Type:

Start-up Imageffor comman cameras) ~|

My Computer

22 & Startup Sound
ANIMALDZ2_5101.JPG Shutter Sound
ANIMALOZE_5I01.JPG

BAR21_SIOTJPG Dperation Sound

BASEBALL21_SI0N JPG
CHIMPAMZ1_SIO.JPG
ETHDANCEZ1_SIDLIPG
ETHTECHNZ21_SI01.JPG
FUMZ21_SI01.JPG

FUNZ2_SI01.JPG
FUNZ3_SI0T.JPG
FUN24_SI01.JPG
GAKKIZ1_SI01.JFG
H GAME21_SI01 JPG
Add File Button -

GAMEZZ_SI0T.JPG ——
i i GAMEZ3_SI.JPG
Adds images and sound f_||es fgr use e Canon
as settings files. Added files display HORSERAL21_SID1.JPG

I7ASHIZ1_SI01.JFG

Selftimer Sound

[

i i KaBUKIYD21_SI01.JPG
in the list. KIKORIZ1 51T JPG ]
Connect to camera Button - R Connect o camera |

Connects to the camera.

Cloze I

My Camera Maker will start.

=5 My Camera Maken

of the My Camera Maker window and
create image or sound files.

Start-up Image Creating

Click [Open] and select a JPEG image

Instructions

‘ 7. Startup Image

Open
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4 once you have saved the file, click &) and close the My Camera Maker window.
You have now succeeded in adding the file as a settings file to the computer.

5 1o connect to the camera, click BAMEZ1 G107 JPE
GakE22_SI01.JPG
[Connect to Cameral]. GaMES7 2101 PG
H H H GOLF21_SI01.JPG Canon
You can add the settings files you just HORSERALSL & 01 4G <
added to the computer to the camera using IYASHIZ1_SI07.JPG
- . FABUKINDZT_SIN.JPG
the same procedures as in "Saving the My KIKORI21 S/ JPG
Camera Settlngs to the Camera " (p 41) Add File. .. | Create by Camera datal
i | _oeme | (Comsctocamas )
Close |

e Use settings like those below when creating an image file for the start-
up image using an image editing program other than My Camera

Maker.
Compression Method : JPEG (Baseline JPEG)
Data Sampling :4:2:0 or 4:2:2
Pixels (w x h) : 320 x 240 pixels

eUse settings like those below when creating a sound file using a sound
recording program other than My Camera Maker.
Compression Method : WAV (Monaural)
Quantifying Bits : 8 bit
Sampling Frequency : 11.025 kHz or 8.000 kHz
Use the following lengths as guidelines for the length of sound file that
can be saved to the camera.

Duration in Seconds
Type
11.025 kHz 8.000 kHz
Start-Up Sound 1.0 sec. or less 1.2 sec. or less
Shutter Sound 0.3 sec. or less 0.4 sec. or less
Operation Sound 0.3 sec. or less 0.4 sec. or less
Self-Timer Sound 2.0 sec. or less 2.0 sec. or less




This chapter explains the basic procedures for installing the software. Read this material before
you connect the camera to the computer for the first time.

Installing the Software

Start by installing the software from the Canon Digital Camera Solution Disk.

See ArcSoft PhotoStudio (p. 72) for details on how to install ArcSoft
PhotoStudio.

ltems to Prepare

e Your camera and computer
e Canon Digital Camera Solution Disk
e Interface cable supplied with the camera

Installation Procedures

Close any programs that are running.

Place the Canon Digital Camera Solution Disk in the
computer’s CD-ROM drive.

3 Double-click the [Canon Digital Camera Installer] icon

@ in the CD-ROM window.

4 Click the Digital Camera Software
[Install] button.

|
Installer Panel
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Select [Easy Installation] and click T —
[Next] . Sabect an intallatioe type and chick [Next).

Select [Custom Installation] to select e

programs individually for installation.
Curtom Installabon

Lets you sebect the Programs you want te install. We recommend this option for users
famikar with the instailarson.

Cancel

Click [Agree] if you agree to all of the e .@ 2

. Disagree
terms of the software license

agreement.
Review the installation settings and String nsaton
Click [NeXt] . Instaliation will begin using the sertings isted below. Click [Next] to start cogying files.
Follow the onscreen instructions to P
proceed. '
g

& Gancel ) 5 crack

Q‘bi Installation has finished.
4

When the installation is over, click [OK].

Click [Exit] in the installer panel and
remove the disk from the CD-ROM drive.

This concludes the software installation.

See Uninstalling the Software (p. 74) to delete the software installed
with these procedures.

Continue by downloading images to the computer (p. 46).



This chapter explains the procedures for using ImageBrowser to download the camera's images
to the computer and print them.

Read this chapter after completing the preparations in the Using the Software on the
Macintosh Platform — Preparations section.

Downloading Images to the Computer

Begin by downloading the images to your computer. The downloading procedure is slightly
different according to whether you are using a camera to computer connection (see below) or
a memory card reader (p. 48).

Camera to Computer Connection

1 Attach the supplied interface cable to the computer’s USB port and the camera’s
DIGITAL Terminal. Prepare the camera for communication with the computer.

Procedures for attaching the camera to the computer and placing it in
the correct mode for connecting vary between camera models. See the
Camera User Guide.

The Camera Control Window will appear.

If it does not open, click the [CameraWindow] icon in the Dock (the bar at the bottom of
the desktop). To set whether this window automatically opens when you connect the
camera to the computer, remove the check mark from the [Start when a camera is
connected] in the [File] menu in the Camera Control window.



2 Dbownload images. 000 XXOOUHKHIKNKAK.

Download the images using the camera or (SRS Print
the computer. By default, the downloaded
images are saved into the [Pictures] folder.

| Setto Camera | Remote shooting )

Downloads using camera

O
m Press the camera's button

. Download il it
Camera Control Window Whoads using computer

Starts to download images
You can adjust the settings, such as the type

of image downloaded and the destination 5851] Lets vou select and download images
folder, by clicking [Preferences]. S=) ! !

@

Using the Camera to Download Images (Direct Transfer Function)

e If the conditions are right for the Direct Transfer function, the Direct
Transfer settings menu will appear in the LCD monitor. In addition, the
Dyas (Print/Share) button will light if your camera is equipped with one.

¢ See the Camera User Guide for instructions regarding Direct Transfer
settings and procedures.

Set the Direct Transfer settings on the
camera and press the Dhas (Print/Share) Vs ~
button or the [SET] button.

Direct Transfer
ALl Images...
New Images...
[ DPOF Trans. Images...

= Select & Transfer...
3 Wallpaper...

Using the Computer to Download Images
Click [Starts to download images]. 000

HOOOOOCHXHXXK

[FAcquire Images | Print | Setto Camera | Remote shooting |

Downloads using camera

22
Press the camera's button

Downloads using computer

éfﬁ Starts to download images

,_t_ Lets you select and download images
==

47
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* By default, all the images that have yet to be downloaded will download.

¢ To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the image type to be downloaded.

e Click [Lets you select and download images] to show the camera images
in a list, check the images before downloading and download only
selected images.

By default, when the download is complete, the thumbnails (tiny versions) of the
downloaded images display in ImageBrowser's Browser Window.

anns Bty Wit

(—
The downloaded symbol 8 oren e
displays on downloaded T
folders (the symbol will B inun
disappear when you exit B sor o1
ImageBrowser). v D oo oy
Thumbnail

Continue by printing out an image (p. 50).

Memory Card Reader Connection

Insert the memory card into the reader.

Use a separately sold card adapter if required.
See the manual for the memory card reader for details on how to connect and use the
reader.

The Camera Control Window will appear.

If it does not open, click the [CameraWindow] icon in the Dock (the bar at the bottom of
the desktop). To set whether this window automatically opens when you connect the
camera to the computer, remove the check mark from the [Start when a camera is
connected] in the [File] menu in the Camera Control window.
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2 Click [Starts to download images]. noo CANON_DC
——{ AcquireImages | Print _ Set to Memory Card -——

Starts to download images

You can set the type of image to download
and the destination folder by clicking
[Preferences].

Lets you select and download images

Preferences__)

folder.

¢ To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the type of image for downloading.

oClick [Lets you select and download images] to show the memory card
images in a list, check the images before downloading and download
only selected images.

®See Memory Card Folder Structure (p. 77) for information about
memory card folder structures and file names.

Iﬁl ¢ By the default settings, all images are downloaded to the [Pictures]

By default, when the download is complete, the thumbnails (tiny versions) of the
downloaded images will display in ImageBrowser's Browser Window when downloading
is complete.

Continue by printing out an image (p. 50).
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Printing Images

There are three ways in which images may be printed: One Photo per page Print, Index Print
and Layout Print. This section explains the One Photo per page Print method.

Movies cannot be printed, but you can print stills after they have been
extracted from movies and saved to files.

One Photo per page Print

This option prints one image per page in a standard "photo" format. If you select multiple
images, it will print them on the corresponding number of pages.

1 select the images to print.
Clicking on an image selects it and displays a blue frame around it. To select multiple

images, hold down the [shift] or [§8 ] (command) key while clicking on images.

ana
Foider

= ol e[l B —0——AA|[ e 2B A blue frame

- | ~ = 2 Y 5 displays z?round
R . selected images.

e St 1 Tt ¥ e

2 Click [Print] and select [One Photo per

page Print]. % ‘ g

Intermnet -

----- erd To
One Photo per page Print...
T N e e
IndeR
Layout Print...

Selecting [Index Print] allows you to print the thumbnails and shooting
information in a chart.

Selecting [Layout Print] allows you to layout and print multiple images on
a single sheet of paper.
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3 Ssetthe categories as you feel necessary.

ene One Fhoco per page Frint
Prisaer ————————— Preview
Selects a printer. =
Page Setup.
Selects options such as the paper size i
and orientation when you click Oveenuicn:  Landscaoe
[Page Setup] Click [Page Setwp] 10 enable

Boaderiess printing on suppared
printers.

Configures the auto trimming

: Page Layout Settings
function. |
Auto Trim

Sedect addaional information to ——r—

Place a check mark here to print the ki B == :
shooting dates/times with the N -y =y e
images. 3 shooting Time £ B W
Test color: - etate ot T
Sets the number of copies printed. —oe ) )

Click this button to switch between
images if you selected multiple
images.

4 Click [Print].
The Print window will now open.

5 After setting the number of copies, and other settings, click [Print].

6 After the printing finishes, click # to close the window.

This chapter explained the ImageBrowser basics.

Once you have mastered them, try the advanced techniques.
Using the Software on the Macintosh Platform — Advanced Techniques (p. 52).

A PDF-format manual for ImageBrowser is also available. It provides further
information about the program's features and procedures. See Using the PDF
Manuals (p. 2).




This chapter explains various ImageBrowser features.
Proceed to this chapter once you have mastered the basic ImageBrowser procedures in the
Using the Software on the Macintosh Platform — The Basics chapter.

To confirm whether your camera supports these functions, please refer to
Information about Your Camera (p. 87).

The ImageBrowser Windows

This section describes the principal ImageBrowser windows: the Browser Window, Viewer
Window and File Information Window.

This window is for displaying and organizing images downloaded to the computer.

Browser Area (p. 53) Display Mode (p. 54)

[-Xs)s Sm— Wi —
Folder _ st §
All I’
B File Mame: . a1
| Macified: e, Biay TF,
File Saze: L
Imasyr fuse 16902 1200
Bt Type. 5
domm: ]
Lok g
e Rating
T ]
v Commanm d

| MG_0001JPG IMG_0002 PG MG_D003 . PG IMG_DOD4 PG BAG_0005 PG
If s

[ Bt L10 view [show Al 18] —Q—G. @, Salecting images || () G5 (&)
o= -
e (G 22 E 8

o of bl bt | / Tocak  brugen

Explorer Panel (p. 53) Display Control Panel (p. 55) Control Panel (p. 55)



53

Explorer Panel

¢ Use this area to select folders. The images in the selected folder display in the Browser Area.

e If you selected Favorite Folders, only the folders registered in advance as Favorite Folders will
display. You are recommended to register a folder that you use frequently as one of the
Favorite Folders. If you selected All Folders, all the folders will display.

Methods for Registering a Favorite Folder
o |f [Favorite Folders] is displayed: click [Add] and select a folder.
o |f [All Folders] is displayed: select a folder and click [Add to Favorites].

Browser Area

e The images in the folder selected in the Explorer Panel will display here.
The display style will vary according to your Display Mode selection.

Methods for Selecting Images in the Browser Area

e Selecting a single image: click on an image.

e Selecting multiple images: click on the first image and then hold the [shift] or [$§ ]
(command) key down while clicking on additional images.

e Selecting consecutive images: click on the first image and then hold the [shift] and
[option] keys down while clicking on the last image.

¢ The following types of icon will display around images according to their attributes.
Chad Images shot with the camera's Stitch Assist mode
RAW images
"W \ovies
mﬂ Images with sound memo attachments
[B=]  Protected images
&y Images shot with the camera's AEB function
¢

Images shot with the camera on end that are rotated in the display only
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Display Mode
o Selects the display style for the Browser Area.
Preview P
This mode displays the image at a larger size as : prevee _nt_TimeTorne

well as the image information.

List
Displays the images in the folder selected in the
Explorer Panel section in rows and columns. =)

G000 PG G OO06_IFG MG D007 PG

TimeTunnel

Displays images in chronological order in a
simulated time tunnel. You can move along a
timeline from the past to the present using the
slider that appears at the window's right.
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Display Control Panel

¢ This panel adjusts the display settings for the Browser Area.

Display Size Selection Menu

Changes the size of the thumbnail in Use this to select or deselect all

the Browser Area. the images in the Browser Area.
View  Show All [+ a, @ | | Selecting Images v| ‘( &)

I 1 I 1 1 1

Filter Images Hide Buttons ———
This feature filters your images by their Star Left:  Hides the Explorer Panel.
Ratings, displaying only those images in the Middle: Hides the control panel.
Browser Area. Right: Hides the image
One of three Star Ratings can be assigned to information in the Preview
an image in the Viewer Window, the File display mode.

Information Window, or in the information
column in the Preview display mode.

Control Panel
¢ The control panel contains buttons for executing various functions.

3 B 0 Waa \3

Canon Camera View Irnage SlideShow Internet - Frint - Send to Trash

The functions displayed here are explained in the Control Panel Features section (p. 58).
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Double-click an image in the Browser Area to display it in the Viewer Window.

eos8 A MG 0001 JPC
Zoom
Changes the
image zoom
setting.
(Fotain W o W Star Ratings
«r| & e = = : | S = Menu
- Rt i Tod o e [y Pkt s Sets the Star
Drplan Mer A0 w12 ey e r Rating for an
Image Selector Button Image.
Switches between .
images. Show Information Button

Displays the AF frame
(focal point frame) and

Save Button the shooting information.

Saves the edited image.

Print Button

Edit Menu Prints the displayed image.

You can edit, performing such things as
cropping, adjusting colors and brightness,
eliminating red eyes and inserting texts.
You can also use it to start up other
programs for editing.

Full Screen Button

Displays the image in the full screen
mode. (You can also double-click an
image to display it in full screen mode).
Click the image or press any key on the
keyboard to restore the normal display
mode.

Number of Displays Menu
Displays multiple images at
once. This is handy for .
comparing images. Synchronize Button
Synchronizes the display
settings when multiple
images are displayed.

¢|If a RAW image is displayed, the [Show Original Image] button displays
beneath it. Clicking this button displays the converted image in the Viewer
Window.

¢If a movie file is displayed, the [Save as Still Image] button will display
beside the Star Ratings.




|57

File Information Window

The File Information Window displays when you select an image in the Browser Area, click the
[File] menu and select [Get Info]. The File Information Window does not display in the Preview
display mode.

Star Rating Menu
Sets the Star Rating for an image.

DOO File Infarmation

Shows or hides ; -
categories.

¥ Comment

Comment
You can type a comment
here.

Plays a sound

memo attached :I:g':: ::—I:::m_ 005 10:56 AM Keyword
to an image. LR L= T Sets the keywords used in
i 5 searches.
Sound. .1
Lock Brightness Histogram
Prevents an image | A graph of the_hlg_hllg_hts
from being “m_mm and shadows distribution
overwritten or e in an image.
deleted. Burarsiisme UMM
zl:m mﬂ e Emmm
g rmacsbeom S
o =y BEET =
Image Selector Buttons Shooting Information
Switches between images. Displays detailed information
about the shooting settings when
the image was captured, such as
the shutter speed or exposure

setting. The camera model will

File Name determine what information is
You can change  gjsplayed.

file names.
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ImageBrowser Features

This section provides a brief introduction to ImageBrowser features.

To confirm whether your camera supports these functions, please refer to
Information about Your Camera (p. 87).

Control Panel Features
E d @ & 8

Canon Carmera View Irmage SlideShaow Internet - Frint - Send to Trash

Canon Camera
Opens the Camera Control Window, which lets you perform the following operations.

Acquire Images

Downloads images from the camera/memory card (p. 46, 48).

Additionally, you can download sound files recorded with the Sound Recorder function on
the camera. Refer to the ImageBrowser PDF manual or Help for download instructions.
Print

Selects and prints the images in a camera or memory card. You can print numerous ways:
print all images, print a contact sheet (index) of all images, print using DPOF settings, or by
selecting images before printing.

Set to Camera
Sets camera settings, such as the My Camera settings (p. 67). It also uploads images from the
computer to the camera.

Remote Shooting
Allows you to operate the camera shutter from the computer (p. 63).

View Image
Displays the selected image or movie in the Viewer Window.

SlideShow

Starts a slide show of the selected images. Click the [View] menu and select [Slide Show
Options] to set the slide show settings.

Internet

Create Images for Email
Converts the selected images to the appropriate size for transmission by e-mail. You can also
use it to automatically start an e-mail program after conversion.
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Print

One Photo per page Print
Prints one image per page (p. 50).
You can print "photo" prints easily.

Index Print
Lines up small versions of the images in rows and prints.

Layout Print
Allows you to freely arrange multiple images on a single page and print. You can also insert
captions and titles.

Send to Trash

Sends the selected images or folders to the Trash.

Functions Selected from Menus

Search Images: [File] menu, [Search]
Searches for images based on such criteria as Star Ratings, dates, keywords or captions.

Export Images: [File] menu, [Export Images]
e Edit and Save: allows you to change the file type or size and export the file.
e Export Shooting Properties: allows you to export the shooting properties as a text file.
e Export as a Screensaver: Exports the image as a screen saver file.
e Export an Image as Wallpaper: Exports the image as a wallpaper file.

Organize Images: [File] menu, [Organize Image]

eSort Images: sorts images according to criteria such as the shooting date or Star Rating and
saves them into a specified folder.

*Rename: changes the files names of multiple images in a single pass.

Convert RAW Images: [File] menu, [RAW image processing]
Converts RAW images. You can adjust the image brightness, contrast and color balance

among other attributes during conversion.

Merge Panoramas: [Edit] menu, [PhotoStitch]
Merges multiple images and creates a single large panoramic image (p. 66).

Edit Movies: [Edit] menu, [Movie Edit]

Edits movies or still images strung together. You can add titles or background music and
apply various effects (p. 62).

Extracting Stills from Movies: [Edit] menu, [Extract frames from a movie]
Extracts still images from movies over a specified interval and saves them as image files.
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Display Settings: [View] menu, [View Settings]

Hides or shows image information beneath the thumbnail, such as the file name or the
shooting date and time.

Sort Images: [View] menu, [Sort]

Arranges image order in the Browser Area according to criteria such as the filename, file
modification date, file size or shooting date.
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Replaying Movies

1 Double-click an image with a movie icon in ImageBrowser’s Browser Area.
The movie will appear in the Viewer
Window.

‘-

Movie icon

2 Click the | # button.

ane s MV 2340.4V1

You can control the

movie's playback and
sound volume.

ntaMe

You can save the displayed scene
as a still image by clicking here.
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om® L]
Editing Movies
You can create and edit movies: link movies and stills that have been downloaded to your

computer, add background music, superimpose titles and other text, and apply various effects
to the movies.

1 select the image(s) to edit in ImageBrowser’s Browser Area (movies or stills).
You can select multiple movies or stills.

2 Click the [Edit] menu and select [Movie Edit].

3 Follow the steps displayed in the middle of the window to edit the movie and save
it.

— Follow these steps
to proceed.

MovieEdit Task

Arange images m
o jact 1he image and click on tha [Move Lefi] or (Move Right] button

o paaythe aranged effects and check them |

26 to Effect Step

Instructions

— Click this button
for detailed
operational
instructions.

€

Plary Time 005,

— Click this button Storyboard Area Transition Effect Box
to play the movie Displays thumbnails of the Appears between adjacent
being edited. selected images. images and displays the
Links images in order from symbols of the transition

left to right. effects linking images.



Operating the Shutter Remotely

You can record still images by using a computer to control the shutter of a connected camera.
This is particularly useful for checking images on the larger display of the computer as you
record them and for high volume photography without worrying about filling the camera’s
memory card.

Preparing for Remote Shooting

1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

¢ Methods for connecting the camera to the computer and placing it in
the correct mode for connecting vary between camera models. Please
refer to the Camera User Guide.

¢ |f the Camera Control Window does not automatically appear, click the
[CameraWindow] icon in the Dock (the bar at the bottom of the
desktop).

The Camera Control Window will display.

2 Open the lens cover or remove the lens cap on models equipped with them.
Proceed to the next step if your model does not have one.

3 Click the [Remote shooting] tab. 000 XIXRRKK

c
[ Acquire Images | Print_| Set to Camerd | Remote shooting | l

Starts Remote Shooting

(preferences. )

4 Click [Starts Remote Shooting].

B sclect a destination for the captured images and click [Choose].

63
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RemoteCapture Task Window

The RemoteCapture Task window has the following features.

Size and Resolution Selector

Shows/Hides the Selects the size and resolution at which
viewfinder or images are captured.

detailed settings

area.

Rotation Settings
8enn RemoteCapture Tas Sets the rotation

= T parameterSfor
& g Release images after they are

¥ Hide ViewFinder

¥ Hide shooting details o Y v
—— == tured
You can add =——————— | Add comments shown below cap "

comments to images
by placing a check
mark here and
typing text in the
boxes below.

Release Button
Releases the
shutter.

e

Slide this to zoom
the camera in or out.

Viewfinder Display
Click the [Start/Stop
Viewfinder] button
while a connection to
the camera is open to ;’ Field angle/flash_|_Shooting settings |

§in) —— Start/Stop Viewfinder
s Button
| Starts or stops the

viewfinder display.

dlSplay the image Focusing Paint: Flash:
appearing in the Manual selectio |9 [ OF B Refresh Button
camera’s viewfinder. Macro: FlashQuality: Resets the exposure,
| for o Y focus and white
AF-assist light: balance.
AF operation:
AF unlock =

Set the camera shooting settings here.

e The settings available in the RemoteCapture Task window vary between
camera models.

e RemoteCapture Task locks the exposure and focus settings for the subject
matter in the Viewfinder section. If the lighting or distance to the subject
changes, click [, to reset these settings.
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Remote Shooting

Ensure that you turn off your computer’s sleep mode before you begin remote
shooting. The device performance cannot be guaranteed if the computer
enters the sleep mode.

Click and check the subject in the viewfinder.

Change the image size or resolution, the rotation settings and the settings at the
bottom of the window as required.

If you intend to hold the camera vertically to photograph a subject, you can save the
image to the computer with the correct orientation if you set the rotation settings in
advance.

function and you set it to On, the image will automatically be rotated
and appear in the correct viewing orientation in the RemoteCapture Task
window.

Iﬁl If your camera’s shooting mode is equipped with the Auto Rotate

3 Click the [Release] button.

or the keyboard'’s space key.

e Other than the shutter button, the camera's buttons and switches,
including the zoom, cannot be operated while the camera is being
controlled with the Remote Shooting function.

* You may notice that the interval between the shutter release and
activation is slightly longer for remote shooting than when the camera
is used independently.

@ * You can also release the shutter by pressing the camera’s shutter button
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Merging Panoramic Images - PhotoStitch

You can create a wide panoramic image by merging several images. It is easier to merge
images if they are shot with the camera's Stitch Assist mode because PhotoStitch can
automatically detect the image order and orientation.

Images Shot in Stitch Assist Mode

A sequence of images shot in Stitch Assist mode is saved into a single folder when it is
downloaded from the camera. In addition, the symbol below displays by the image in the
Browser Area.

Symbol displayed by images shot in Stitch Assist
mode.

e See the Camera User Guide for information about shooting in
Stitch Assist mode.
eImages shot in Stitch Assist mode with a wide converter,
teleconverter or close-up lens cannot be merged accurately.

Starting PhotoStitch

T select a series of images in the ImageBrowser’s Browser Area.

Click the [Edit] menu and select enn. Phatasiinh
[PhotoStitch].

Instructions

STA_DSTBPG | STEOSTIUPG | STC_OSBOUPG | STO_OSE1.PG

P e 3 2997 % 1944 Tr e Coleer

3 Merge the images following the
instructions in the guidance panel at the top of the PhotoStitch window.
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Enjoy Customizing Your Camera with the My
Camera Settings

The start-up image, start-up sound, shutter sound, operation sound, and self-timer sound are
called the My Camera settings. You can add your favorite images and sounds from your
computer to the My Camera settings. This topic explains how to upload the My Camera
settings saved onto your computer to the camera and vice versa.

Displaying the My Camera Window

1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

e Procedures for attaching the camera to the computer and placing it in
the correct mode for connecting vary between camera models. See the
Camera User Guide.

¢ |f the Camera Control Window does not automatically appear, click the
[CameraWindow] icon in the Dock (the bar at the bottom of the
desktop).

The Camera Control Window will display.

2 Click the [Set to Camera] tab. 0006 ICRRRXKIIOKKKK

([(—
" Acquire Images PIiI‘ | “Setto-€amera | Iemme shoating |
—r

Set My Camera

Confirms /changes camera settings

ﬁu Uploads images to the camera
i

( Preferences... )
3 Click [Set My Cameral.
The My Camera window will display.
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The My Camera Window

ImageBrowser already contains several pre-recorded My Camera settings items. You can check
these items with the My Camera window.

Type —— Save to Camera

Select the settings type. B Play Button
Save to Computer Plays the audio from
the settings file in the
camera.
Displays the list
of settings files T My Camera '
saved onto the Tyel: (e i Displays the
computer. settings in the
B camera.
3:221
== Delete Button
Deletes a settings
file from the
= = camera.
K Play ) Canon
Save Toflac 05 10.3.x:Users-dng:Library Preferences-imageRrowserUserData:
MyCamefaFiles
e 1o Coriga”) (R
Play Button Send to Trash Button Save to Camera Button
Plays the audio from the Deletes a settings file Click here to save the
selected settings file. from the computer. settings onto the
camera.
For cameras that can only register one P
My Camera setting, the [Return to L1zl
factory default settings] button will
display. Clicking this button will return P e ) o )
the My Camera setting to the factor =
d f |¥t tt g y ( Return to factory default settings )
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Saving the My Camera Settings to the Camera

Iﬁl e My Camera settings can be selected and saved in either of two ways to the

camera: individually or in theme sets.

*The “Animal” theme, for example, features an animal in the start-up image
and animal calls in each of the sound files. The names of the prepared files
for the various My Camera settings themes all begin with the same root
name. The start-up image and sound files in the "Animal" theme, for
example, all begin with “Animal~".

o Do not detach the interface cable, turn the camera power off or disconnect

W=

Saving the Camera’s My Camera Settings to the Computer

Select the type of setting you wish to save to the computer from the Type list box.

DN

the camera from the computer while the My Camera settings are being saved
to the camera or the settings from the camera are being saved to the
computer.

Select the type of setting in the Type list box that you wish to save to the camera.
Select the setting from the Computer list that you would like to add.

Select the setting in the Camera list that you would like to change and click the
button.

The Camera list setting will change to the selected file. If a setting for this category has
previously been saved to the camera, it will be overwritten.
Repeat steps 1-3 as required.

Click the [Save to Camera] button.

This concludes the process of saving the My Camera settings to the camera.
To use this data on the camera, change the start-up image and sound settings on the
camera itself. Please see the Camera User Guide for these instructions.

Select the setting in the Camera list that you wish to save to the computer.
Click the [ - | button.
Input a file name to the selected setting and click the [OK] button.

This concludes the process of saving the My Camera settings to the computer.
Repeat steps 1-4 as required.
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Adding New Data to the My Camera Window

Create a new image or sound file and add it to the My Camera window.
¢ Adding Image and Sound Files After Creating Them

Create an Original Start-up Image File and then Add It
Start by using an image editing program to create the image file that will become the start-up
image and save it to the computer.

1 Cdlick the [File] menu in the ImageBrowser Main Window and select [Canon
Camera] and [My cameral.
The My Camera window will display.

2 Ssclect the [Start-up Image] in Type.

3 Click [Add].
BARZ21
BASEBALLZ21
CHIMPANZ1 e
ETHDANCE21 _L'l
Add Button Add [ Send to Trash
Adds Images and ( Play ) ( Connect to camera ) Canon
sound files for use as ==
settings files. Added Save To:Mag 0s 10.3.x:Users:eng:1iblarv:Preferen(es:lmageBrowselUserData:
MyCameraFiles:

files display in the list.

Save to Camera

Connect to Camera Button
Connects to the camera.

4 sciect the file you created and click [Open].
This concludes the process for adding new data.

5 To connect to the camera, click [Connect to Cameral].

You can add the settings files you just added to the computer to the camera using the
same procedures as in "Saving the My Camera Settings to the Camera" (p. 69).
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Add an Original Sound File

Change the file to a WAV sound file after you have copied the sound file to the computer.
Then proceed with the steps as described in Create an Original Start-up Image File and then
Add It.

¢ Use settings like those below when creating an image file for the start-
up image with an image editing program.
Compression Method : JPEG (Baseline JPEG)
Data Sampling :4:2:0 or 4:2:2
Pixels (w x h) : 320 x 240 pixels
¢ Use settings like those below when creating a sound file with a sound
recording program.
Compression Method : WAV (Monaural)
Quantifying Bits : 8 bit
Sampling Frequency : 11.025 kHz or 8.000 kHz
Use the following lengths as guidelines for the length of sound file that
can be saved to the camera.

Duration in Seconds
Type
11.025 kHz 8.000 kHz
Start-Up Sound 1.0 sec. or less 1.2 sec. or less
Shutter Sound 0.3 sec. or less 0.4 sec. or less
Operation Sound 0.3 sec. or less 0.4 sec. or less
Self-Timer Sound 2.0 sec. or less 2.0 sec. or less




This chapter introduces and explains how to install ArcSoft PhotoStudio, which is on the CD-
ROM supplied with your camera. It also explains how to uninstall the programs.

Read the Troubleshooting section in this chapter if you experience a problem using the
programs.

ArcSoft PhotoStudio

ArcSoft PhotoStudio is a high-performance yet easy-to-use image editing program from
ArcSoft, Inc. It can process, edit and print images. It includes color corrections, brightness
adjustments and special effects. Install it from the supplied CD-ROM, the Canon Digital Camera
Solution Disk, as required.

Installing ArcSoft PhotoStudio

Windows

1 Ccloseall programs that are running.
2 Place the Canon Digital Camera Solution Disk in the CD-ROM drive.
If the installer panel displays, click [Exit] to close it.

3 Click the [Start] menu, and select [My Computer].

Windows 2000, Windows Me and Windows 98 SE users, double-click the [My Computer]
icon on the desktop.

4 Right-click the CD-ROM icon and select [Open].
5

Double-click the [ARCSOFT] folder or right-click it and select [Open], and double-
click the [SETUP.EXE] icon EN.

Follow the onscreen messages to proceed with the installation.
Macintosh

1 Ccloseall programs that are running.
2 Place the Canon Digital Camera Solution Disk in the CD-ROM drive.

3 Open the CD-ROM and double-click [ARCSOFT], followed by the [PhotoStudio
Installer] icon .

Follow the onscreen messages to proceed with the installation.

4 cick [OK] when a message appears stating that the installation is complete.
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Starting ArcSoft PhotoStudio

You can start ArcSoft PhotoStudio from within ZoomBrowser EX (Windows) or ImageBrowser
(Macintosh).

ZoomBrowser EX

Click [Edit] in the Task Area of the Main Window, followed by [Edit Image].
Confirm that [1. Select Images] is selected and select an image to edit.
Click [2. Select Editing Tool] and select [Edit with external image editor].
Select ArcSoft PhotoStudio from the program list and click [3. Finish].

DWN=

If you cannot select ArcSoft PhotoStudio, register the program using the

following procedures.

1.1n Step 3 above, select [Edit with external image editor] and click
[Manage List].

2.Click [Add] and select [ArcSoft PhotoStudio].

ImageBrowser
1 selectan image to edit, click the [Edit] menu and select [ArcSoft PhotoStudio].

Manual for ArcSoft PhotoStudio

You can obtain the ArcSoft PhotoStudio manual from the ArcSoft, Inc., website. Use your
browser program to download the manual from the following URL:
http://www.arcsoft.com/support
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Uninstalling the Software

The procedures for uninstalling the software are only required when you wish to delete the
programs from your computer or when reinstallation is required to fix corrupted files.

Uninstalling the Software (Windows)

Software Installed from the Canon Digital Camera Solution Disk (excluding
ArcSoft PhotoStudio)

This explanation uses ZoomBrowser EX to demonstrate how to uninstall a program. You can
remove other programs with the same procedures.

1 Click the Windows [Start] menu and
select [All Programs] or [Programs],
followed by [Canon Utilities],
[ZoomBrowser EX] and [ZoomBrowser
EX Uninstall].

v"edMEO0O0O0OCOOOO
SRR ER

The uninstall utility will start and remove
ZoomBrowser EX.

Uninstalling ArcSoft PhotoStudio

e Uninstall the program by clicking the [Start] menu and selecting [Control Panel] and [Add or
Remove Programs].

e With Windows 2000/Me/98, uninstall the program by clicking the [Start] menu and selecting
[Settings] followed by [Control Panel] and [Add/Remove Programs].
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Uninstalling the USB Driver (Windows)

Uninstall the USB Driver using the following procedures if you are using Windows 2000,
Windows Me or Windows 98 SE.

0 It is essential to note that you will not be able to download images if you
uninstall the USB driver.

Iﬁl You do not need to uninstall the USB driver with Windows XP.

1 Attach the supplied interface cable to the computer’s USB port and the camera’s
DIGITAL Terminal. Prepare the camera for communication with the computer.

For interface cable connection instructions, see the Camera User Guide.

2 Click the [Finish] button if the Camera Control Window displays.

3 Click the [Start] menu and select r =
[Settings], followed by [Control Panel].

Taskbar & Stark Menu...

Hstert | ] & 2 O ]|

4 Double-click the [Scanners and
Cameras] icon or folder. T oms

| - = - | Dseoch Troer (3|4 W K o | F-
tebdess | =) Cortrol Panel

o0 @ @ oa e
dscombley  dibuove sciliancre ASthauNe Mg |
Control Panel Dptiers deare Prograes Uplales
I H o4 %
Digley  Foder Optiore  Forks Gatieg Inkerret
St 1 e i s £ gt Cntiorn Ordxers
v < H @ li =)

Mouss  Networkand  Phoneand  PowerOptions  Frivkers

(g Co...  Modes .
2y « 8 @
Scaners and feduled Sounds and System Lisaws and
Cttenrit & Multmadsy Pasttwinds
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5 Delete your camera model name or i
[Canon Camera] in the [Scanners and

Cameras Properties] dialog.
Windows Me users should delete their %

camera model or [Canon Camera] in the The f nhers of cameras are installed
[Scanners and Cameras] folder.

Devices |

Add \)

Troubleshoat Fropemies

Windows 2000
Select your camera model name or [Canon Camera] and click [Remove].

Windows Me
Select your camera model name or [Canon Camera], right-click the mouse and select
[Delete].

Windows 98 SE
Select your camera model name or [Canon Camera] and click [Remove]. Then turn off the
camera and remove the interface cable from the computer's USB port.

e th mera not
ot download to the

If your camera model nam
detected, Events dialog
computer (p. 79) of

6 Click the Windows [Start] menu and select [Programs], followed by [Canon
Utilities], [Camera TWAIN Driver x.x] and [Uninstall TWAIN Driver]. A version
number appears in place of the “x.x".

e Windows 2000, Windows 98 SE: Perform Step 6 with no substitutions.
e Windows Me: Substitute the following for the underlined portions of Step 6.
[Camera WIA Driver x.x], [Uninstall WIA Driver]

The uninstall process will start.
To connect the camera to the computer and download after this point, use the following
procedures.

1. Reinstall the driver.
2. Connect the camera to the computer with the interface cable.

Uninstalling the Software (Macintosh)

Uninstall the programs by dragging the application’s folder (the folder in which it was installed)
into the Trash, and then empty the Trash.

Please be careful not to accidentally delete any folders with downloaded
images that may be contained within the application folder.
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Memory Card Folder Structure

The images on a memory card are placed in the [DCIM] folder in subfolders labeled
[xxxCANON], where the “xxx" represents a number in the range 100 - 999.

— IMG_xxxx.JPG (JPEG images)
EI T }— _MG_xxxx.JPG (JPEG images recorded in the

DCIM Adobe RGB color space)
xxxCANON —— CRW_xxxx.CRW (RAW images)
—— RW_xxxx.CRW (RAW images recorded in the

Adobe RGB color space)
—— CRW_xxxx.THM*
—— STX_xxxx.JPG** (Stitch Assist mode images)
—— MVI_xxxx.AVI (Movies)
—— MVI_xxxx. THM*
—— SND_xxxx.WAV (Sound annotation)

The folder that holds the settings files for
images in the DCIM folder.

CANONMSC

The folder created when DPOF settings are set.
It holds the DPOF settings files.

MISC
— EI _— EI SDR_xxxx.WAV (Files recorded with Sound Recorder)
SNDR xxXxCANON

¢ *Files with the THM extension are the thumbnail image files for the camera’s index replay
mode.

e The “xxxx" in file names represent four-digit numbers.

e **Each successive file shot in Stitch Assist mode is assigned a letter starting from “A,” which
is inserted as the third digit in the name. i.e. [STA_0001.JPG], [STB_0002.JPG],
[STC_0003.JPG]...

o All folders except the “xxxCANON" folders contain image settings files. Do not open or delete
them.



78

Appendices

Troubleshooting

Please read this section if you encounter a problem using the software.

Start by Checking This

Investigate the following points first if you encounter a problem.

Does your computer satisfy the requirements listed in the System
Requirements section (p. 8)?

Is the camera correctly connected to the computer?

)

See the Camera User Guide for the correct connection procedures. Also
check to ensure that you are using the correct cable and that it is securely
attached at both ends.

? Is the camera set to the playback mode? (some models only)

Some models require the camera to be set to the playback mode to
transfer data. See the Camera User Guide for details.

? Is the battery sufficiently charged?

Check the battery charge if you are powering the camera with a battery.
You are recommended to use a household power source (AC adapter) to
power the camera when it is connected to a computer (if available for
your camera model).

Problems

Try the suggested solutions to the common problems listed below.

@ USB driver installation not proceeding well (Windows)
Q

Uninstall the driver (p. 75) before reinstalling it with the procedures in Installing
the Software and USB Driver (p. 11).
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@ Add New Hardware Wizard or New Hardware Found (Windows 2000)
g Wizard displays when the camera is connected to the computer with an
interface cable.

Click [Cancel] to close the window. Temporarily disconnect the camera from the
computer. Next, read Start by Checking This on the previous page and resolve
the problem.

@ Images won’t download into a TWAIN-compliant program (Camera and
g computer connected via interface cable (Windows 2000, Windows 98 SE)).

Click the [Finish] button in the Camera Control Window to close it.

@ Cannot download images or shoot remotely. (For cameras connected to
g the computer via an interface cable: only cameras supporting Hi-Speed
USB 2.0).

The problem may be resolved by lowering the transmission speed for data by
following the procedures below.

Solution:

Hold the MENU button on the camera down and press the Lya~ (Print/Share)
button and FUNC./SET button simultaneously. In the displayed screen, select [B]
and press the FUNC./SET button.

@ Camera not detected, Events dialog won't display or images will not
g download to the computer (when camera is connected to the computer
via an interface cable).

Cause 1:

There is a problem with one of the items in the Start by Checking This
section (p. 78).

Solution:
Resolve the problem.

Cause 2:
The USB driver is not installed (Windows only).

Solution:
Install it with the procedures in Installing the Software and USB Driver (p. 10).

Cause 3:

The USB driver is not correctly installed (Windows only).

Solution:
Uninstall the driver (p. 75) before reinstalling it with the procedures in Installing
the Software and USB Driver (p. 11).
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Cause 4:

The camera may have been recognized as another device under the

following circumstances (Windows only).

e The camera was connected to the computer before the USB driver was
installed.

e The [Scanners and Cameras] icon or the [Scanners and Cameras] folder cannot
be found in the [Control Panel] or the [Printers and Other Hardware] window.

¢ Your camera model name, [Canon Camera] or a camera icon does not display
in the [Scanners and Cameras Properties] dialog or the [Scanners and
Cameras] folder.

Solution 1:

Start with the following procedures.

Install the USB driver with the procedures in Installing the Software and USB
Driver (p. 11). Then connect the camera to the computer with the interface
cable and prepare it to transfer data. If the USB driver is already installed,
uninstall it first and then reinstall it.

Solution 2:

If the problem is not resolved with the procedures in Solution 1, continue by

implementing the following procedures. The specific steps are explained below.

1. Check to see if the camera is being recognized as an “other” device.

2. Delete the driver and the setup information files if it is being recognized as an
“other” device.

3. Reinstall the driver.

This section explains the specific steps for each operating system.

Windows XP and Windows 2000

0 of Wi s XP a in 2000 must first n as an
inistrat ompute m inistrator elete a driver.

Check to see if the camera is being recognized as an “other” device and
delete the driver if it is.

1. Windows XP: Click the [Start] menu, followed by [Control Panel],
[Performance and Maintenance] and [System].
Windows 2000: Click the [Start] menu and select [Settings] and [Control
Panel]. Double-click the [System] icon.

2. Click the [Hardware] tab, followed by [Device Manager].
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3. Click the [#] symbol beside the [Other devices] and/or [Imaging devices]

category. Your camera model name or [Canon Camera] will display in these
categories if it is being recognized as an “other” device.
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causes.

There are other potential reasons for the problem if the “Other devices”
or “Imaging devices” categories do not appear or your camera model
name or [Canon Camera] does not appear. Proceed to Step 6,
temporarily quit the procedures and investigate the other potential

4. Select your camera model name or [Canon Cameral], right-click and select

[Delete].

5. Click [OK] in the confirmation dialog.
Delete all instances of your camera model name or [Canon Camera] if it
appears in one or more places in the [Other devices] or [Imaging devices]

categories.

6. Close the System Properties window.

Iﬁl Step 7 and above are not required for Windows XP.

Delete the setup information files

7. Double-click the [My Computer] icon on the desktop, followed by the [C:]
drive, [WINNT] folder and [inf] folder.
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If the [inf] Folder Is Not Visible in the [WINNT] Folder
Use the following procedures to show all files and folders.

. Open the [WINNT] folder.

. Click the [Tools] menu and select [Folder Options].

. Click the [View] tab.

. In the [Files and Folders] category in the Advanced Settings section, set [Hidden files
and folders] to [Show hidden files and folders]. Remove the check marks from [Hide
file extensions for known file types] if it is present.

5. Click [OK] to close the dialog.

MWN -

This will make the hidden files and folders visible.
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8. Look for files for Canon digital cameras that start with [CAP*].
The "*" represents a number, such as 0 or 1.
[CAP*] files come in pairs of [CAP*.inf] and [CAP*.pnf] files (For example,
[CAPO.inf] and [CAPO.pnf]).

9. Double-click the [CAP*] files to check their contents.
Double-clicking a [CAP*.inf] file will open it in the Windows Notepad
program. Look for [;****Canon Camera Driver Setup File****] in the first
line. Note down the names of these files.

es may be present in the [inf] folder. Open up
that it is an [CAP*] file for Canon digital cameras
ything with the file.

10.Delete the [CAP*] file set.
Delete the [CAP*.inf] and [CAP*.pnf] file for Canon digital cameras that you
noted down in Step 9.

The [inf] folder contains numerous files critical to the computer’s
operation. Be extremely careful to delete the correct files. If you delete
the wrong files, you may be unable to restart Windows.



83

Reinstall the driver.

11.Reinstall the driver with the procedures in Installing the Software and USB
Driver (p. 11).

Windows Me/Windows 98 SE

Check to see if the camera is being recognized as an “other” device and
delete the driver if it is.

1. Click the [Start] menu and select [Settings], followed by [Control Panel].
Double-click the [System] icon.
This will display the System Properties window.

2. Click the [Device Manager] tab.

3. Click the [#] symbol beside the [Other devices] and/or [Imaging devices]
category. Your camera model name or [Canon Camera] will display in these
categories if it is being recognized as an “other” device.

Syslom Froperbes Syslom Properbes
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There are other potential reasons for the problem if the “Other devices”
or “Imaging devices” categories do not appear or your camera model
name or [Canon Camera] does not appear. Proceed to Step 6,
temporarily quit the procedures and investigate the other potential
causes.

4. Select your camera model name or [Canon Camera] and click [Remove].

5. Click [OK] in the confirmation dialog.
Delete all instances of your camera model name or [Canon Camera] if it
appears in one or more places in the [Other devices] or [Imaging devices]
categories.

6. Click [OK] to close the System Properties window.

Delete the setup information files.

7. Double-click the [My Computer] icon on the desktop, followed by the [C:]
drive, [WINDOWS] or [Windows] folder and [INF] or [Inf] folder.
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If the [INF] Folder Is Not Visible in the [WINDOWS] Folder
Use the following procedures to show all files and folders.

1. Windows 98 SE: Click the [View] menu and select [Folder Options].
Windows Me: Click the [Tools] menu and select [Folder Options].

2. Click the [View] tab.

3. Windows 98 SE: Set the [Hide files] section to [Show all files].
Windows Me: Set the [Hidden files and folders] section to [Show hidden files and
folders].

4. Click [OK] to close the dialog.

This will make the hidden files and folders visible.
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8. Find and delete the [DRVDATA.BIN] (or [Drvdata.bin]) and [DRVIDX.BIN] (or
[Drvidx.bin]) files.
9. In the [INF] or [Inf] folder, double-click the [OTHER] or [Other] folder to open
it.
10. Find and delete the [Canon.IncCAP xxx.Inf] file (The xxx
represents numerals.).

You do not need to delete anything if none of the above files are
contained in the [OTHER] folder.

The [INF] folder contains numerous files critical to the computer’s
operation. Be extremely careful to delete the correct files. If you delete
the wrong files, you may be unable to restart Windows.



Reinstall the driver

11.Reinstall the driver with the procedures in Installing the Software and USB
Driver (p. 11).

Zooming Images in ZoomBrowser EX is Slow or Not Working

Some graphics cards or settings may cause the display of zoomed images in ZoomBrowser EX
to slow down or malfunction. If this occurs, set your computer display's Hardware acceleration
setting to a lower setting.

1. Click the Windows [Start] menu, followed by [Control Panel] and
[Appearance and Themes].
With Windows 2000, Windows Me, or Windows 98 SE, click the [Start] menu
and select [Settings], followed by [Control Panel].

2. Click the [Display] icon, followed by the [Settings] tab, [Advanced] button and
[Troubleshoot] tab.
With Windows 2000, click the [Display] icon, followed by the [Settings] tab,
[Advanced] button and [Troubleshoot] tab.
With Windows Me or Windows 98 SE, click the [Display] icon, followed by
the [Settings] tab, [Advanced] button and [Performance] tab.

3. Set the [Hardware acceleration] to a setting below [Full] and click [OK].

4. Restart the computer if prompted.

If You Were Using ZoomBrowser EX Version 2 or 3

Take the following steps if you were using ZoomBrowser EX version 2 or 3 with Windows.

If Titles and Comments Were Attached to Your Images.
Take the following steps to display in version 5 the titles and comments you
input in version 2/3.

1. Use Windows Explorer to open the [Program] folder within the folder in
which you installed ZoomBrowser EX 5.
(e.g. C:\Program Files\Canon\ZoomBrowser EX\Program)

2. Double-click [dbconverter.exe] found in this folder to start this utility.

3. Select the database file you were using up to this point and click the [Start]
button.
(e.g. C:\Program Files\Canon\ZoomBrowser EX\Database\My Database.zbd)

This will display the titles and comments input in the earlier versions in the
comments section of ZoomBrowser EX 5.

If You Had Images in a Folder Below the Program Files Folder

Image files in the [Program Files] folder or a subfolder cannot be displayed in
ZoomBrowser EX 5 from that location. To display these files, first perform steps
1-3 above and then carry on with Step 4.
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4. Use Windows Explorer to copy the folder and the images it contains from the

[Program Files] folder to another folder.
(e.g. Copy the image folders in C:\Program Files\Canon\ZoomBrowser

EX\Library One to another location.)

The moved folder images can now be selected and displayed with
ZoomBrowser EX 5.



The software package and the procedures for connecting to a computer and preparing for data
transfers vary between camera models. Certain software functions may also not be supported
by some camera models.

Non-Supported Programs and Features

PowerShot SD700 IS DIGITAL ELPH/DIGITAL IXUS 800 IS
PowerShot SD630 DIGITAL ELPH/DIGITAL IXUS 65
PowerShot SD600 DIGITAL ELPH/DIGITAL IXUS 60
PowerShot A700

PowerShot A540

PowerShot A530

PowerShot A430

PowerShot A420

Non-Supported Functions
*The camera does not record RAW images.

*The camera does not support the Display AF Frame function in the View
Window.

*The camera shutter cannot be controlled from a computer.
*The camera does not support the Sound Recorder function.

Applicable Camera Models

PowerShot S3 IS

Non-Supported Functions

*The camera does not record RAW images.

*The camera does not support the Display AF Frame function in the View
Window.
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